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Support 

──────────────────────────────────────────────────────────── 

Questions? Ask Our AI Chatbot First — Instant Answers 24/7 

Your first stop for help: https://frontieralgo.com/support.html 

Our AI assistant understands AI Channel Trader Pro inside and out. Get instant answers about indicators, 

settings, installation, and more — anytime, day or night. For anything the chatbot cannot resolve, email 

contact is available at the bottom of the support page. 

IMPORTANT: This manual explains how AI Channel Trader Pro functions as an analytical tool. Nothing 

contained herein constitutes investment advice, trading recommendations, or solicitation to buy or 

sell any financial instrument. AI Channel Trader Pro is not a registered investment advisor, broker-

dealer, or financial planner. All trading involves substantial risk of loss; only trade with capital you can 

afford to lose. Past indicator performance does not guarantee future results. You are solely 

responsible for your own trading decisions. 
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Welcome to AI Channel Trader Pro 

──────────────────────────────────────────────────────────── 

Congratulations on your purchase of AI Channel Trader Pro. 

AI Channel Trader Pro is an AI-adaptive channel system that generates dynamic support and resistance 

levels, trend detection, and momentum analysis in real time. The proprietary adaptive algorithms 

analyze price action continuously, giving you a complete visual framework for trade decisions. 

On TradeStation, AI Channel Trader Pro consists of three indicators that work together as a unified 

system: 

1. FA_AIChannelTrader (AI Channel Overlay) — The main overlay on your price chart. Displays 

adaptive channel bands, AI trend line, session VWAP with deviation bands, daily pivot levels, and 

recent high/low reference lines. 

2. FA_AIChannelPulse (Pulse Pro) — A momentum quality oscillator displayed in a separate pane 

below your price chart. Shows whether the trend is strong or fading through a color-coded 

histogram. 

3. FA_AIChannelTrader_PaintBar (PaintBar) — A directional color filter that paints every price bar 

cyan (bullish) or red (bearish) based on the internal trend direction. This is your master directional 

filter. 

This manual will teach you everything you need to know in plain English. No math or programming 

required. 

Don't be overwhelmed. AI Channel Trader Pro is powerful but simple in practice. You do not need to 

memorize this entire manual before getting started. The system is designed to be visually intuitive — 

the channel bands show you where price is likely to reverse, the bar colors tell you the direction, and the 

Pulse tells you the momentum. Our AI chatbot at frontieralgo.com/support.html is available 24/7 to 

answer any questions as you learn. 

NOTE: If you are new to TradeStation, we recommend reviewing TradeStation's official getting started 

guide at help.tradestation.com before proceeding with installation. 
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Part 1: Getting Started — Access and Installation 

Before You Begin — Submitting Your Customer Number 

AI Channel Trader Pro for TradeStation is a protected indicator system. A TradeStation Customer 

Number is required for access. After purchasing, you must submit your Customer Number to activate 

your license and receive your indicator files. 

• Submit your Customer Number at: https://frontieralgo.com/ai_channel/thankyou.html 

• Indicator files are delivered by email after registration is processed. 

• TradeStation 10 is required. Earlier versions (9.x, 8.x) are not supported. 

• TradeStation Web and Mobile do not support custom EasyLanguage indicators. 

How to Find Your TradeStation Customer Number 

4. Open TradeStation and log in to your account. 

5. Click Help in the top menu bar. 

6. Click About TradeStation. 

7. Your Customer Number is displayed in the dialog window. 

8. Copy this number and submit it at the registration page linked above. 

What You Receive 

After registration, you will receive an email containing your indicator files: 

ELD File (EasyLanguage Document) — Contains all three indicators: 

• FA_AIChannelTrader (Indicator) — Main overlay: channel bands, trend line, VWAP, pivots, recent 

high/low 

• FA_AIChannelPulse (Indicator) — Momentum oscillator in a separate subgraph pane 

• FA_AIChannelTrader_PaintBar (PaintBar) — Colors every bar by trend direction 

TSW File (optional, if provided) — A pre-configured TradeStation Workspace with the recommended 

chart layout. 

NOTE: An ELD file is TradeStation's native file format for packaging compiled indicator code. One ELD 

can contain multiple indicators. A TSW file saves an entire chart layout including symbols, timeframes, 

and applied indicators. Opening a TSW restores that exact layout. 
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Installation — Step by Step 

IMPORTANT: The ELD file MUST be imported FIRST before opening any workspace file. The 

workspace references the indicators inside the ELD — opening it first causes errors. 

 

Step 1: Install the ELD File 

9. Save the ELD file to your Desktop or Downloads folder. Do NOT rename the file or change its 

extension. 

10. Open TradeStation and log in. 

11. Click File in the top menu bar. 

12. Click Import/Export EasyLanguage. 

13. Select "Import EasyLanguage file (ELD, ELS or ELA)" from the list. 

14. Click Next. 

15. Click Browse. 

16. Navigate to where the ELD file was saved. 

17. Select the ELD file and click Open. 

18. Click Next. 

19. A list appears showing the contents of the ELD file. Verify all three components are listed and 

checked: FA_AIChannelTrader (Indicator), FA_AIChannelPulse (Indicator), and 

FA_AIChannelTrader_PaintBar (PaintBar). 

20. Click Next. 

21. If a prompt appears asking about replacing existing files (this happens when updating or 

reinstalling), click "Yes to All." 

22. Click Finish. 

23. Wait for the progress bar to complete. This usually takes 10 to 30 seconds. 

24. Import is complete. 

TIP: You can also double-click the ELD file directly to launch the Import Wizard automatically. 

 

Verify Your Installation 

After importing, verify that all three components installed correctly: 

25. Click View in the TradeStation menu bar. 

26. Click EasyLanguage Documents. 

27. In the left panel, expand Indicators — look for FA_AIChannelTrader and FA_AIChannelPulse. 

28. Expand PaintBar Studies — look for FA_AIChannelTrader_PaintBar. 

29. All three should show status "Ready." If they do, the installation is complete. 
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Step 2: Open the Workspace (If Provided) 

If you received a TSW workspace file: 

• Method 1: Double-click the TSW file on your computer. 

• Method 2: In TradeStation, go to File > Open Workspace and navigate to the TSW file. 

The chart opens with all three indicators pre-configured. Change the symbol by clicking the chart, typing 

a new symbol (for example, ES for E-mini S&P 500), and pressing Enter. 

Manual Indicator Setup (Alternative Method) 

If you prefer to add the indicators to your own chart instead of using the workspace: 

30. Open or select a chart in TradeStation (any symbol, any timeframe). 

31. Right-click the chart and select Insert Analysis Technique, or press Ctrl+C, or go to Insert > Indicator 

in the menu bar. 

32. In the Indicators tab, find FA_AIChannelTrader. Select it and click OK. The adaptive channel bands, 

trend line, VWAP, pivot levels, and recent high/low lines will appear on your price chart. 

33. Repeat the Insert process. Find FA_AIChannelPulse. Select it and click OK. It will automatically create 

its own subgraph pane below the price chart showing a colored momentum histogram. 

34. Repeat the Insert process. Look under PaintBar Studies (some TradeStation versions list PaintBars 

separately from standard indicators). Find FA_AIChannelTrader_PaintBar. Select it and click OK. Your 

price bars will now be colored cyan (bullish) or red (bearish). 

IMPORTANT: Only one PaintBar can be active at a time on TradeStation. If you have another PaintBar 

study applied, disable or remove it before adding the AI Channel PaintBar. 

 

What You Should See 

When all three indicators are properly applied, your chart should display: 

• Adaptive channel bands surrounding price (magenta upper bands, cyan lower bands) 

• An AI trend line on price (green when rising, red when falling) 

• Price bars colored cyan (bullish) or red (bearish) from the PaintBar 

• VWAP line with upper and lower deviation bands (on intraday charts, when enabled) 

• Daily pivot levels (when enabled) 

• Recent high/low reference lines (when enabled) 

• Pulse Pro momentum histogram in a separate pane below the price chart 

Step 3: Save Your Own Workspace 

After setting up your chart, go to File > Save Workspace As to create a personal copy. This preserves all 

your customizations, symbols, timeframes, and indicator settings for future trading sessions. 
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First-Time Use — What to Expect 

• Loading time: The indicators need 2 to 10 seconds to calculate on first load, depending on the 

amount of data. 

• Data requirement: At least 200 bars of historical data are needed for the adaptive algorithms to 

produce reliable channel bands. 

• Signal frequency: The system is designed to be selective. It produces fewer but higher-quality trade 

setups compared to generic indicators. 

• VWAP note: VWAP is only meaningful on intraday charts. Allow 30 or more minutes after session 

open for the VWAP bands to become reliable. 

Troubleshooting 

ISSUE SOLUTION 

Analysis technique not found after import Close and reopen TradeStation. The indicator may 

need recompilation. If the error persists, reimport the 

ELD file using File > Import/Export EasyLanguage. 

Indicators not appearing in the list Check that the import completed successfully. Try File 

> Import/Export EasyLanguage again. Check both the 

Indicators category and PaintBar Studies category, as 

the PaintBar may be listed separately. 

Import errors or name conflicts If indicator names conflict with existing studies, 

rename the conflicting studies first, then reimport. If 

prompted to overwrite, click "Yes to All." 

Chart not displaying channel bands Ensure you added FA_AIChannelTrader (not 

FA_AIChannelPulse) to the price chart. Also verify at 

least 200 bars of data are loaded. 

PaintBar not coloring bars Check for conflicting PaintBar indicators. Only one 

PaintBar can be active at a time. Remove other 

PaintBars and re-add FA_AIChannelTrader_PaintBar. 

Pulse Pro on the price chart instead of below Remove FA_AIChannelPulse and re-add it. It should 

automatically create its own subgraph pane below the 

price chart. If it does not, right-click the indicator and 

check the scaling/subgraph settings. 

Performance issues or slow loading Reduce the number of bars loaded in the chart. 200 to 

500 bars is sufficient for the AI Channel system. Close 

other heavy indicator charts if your system is sluggish. 
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TradeStation version error Confirm you are running TradeStation 10 or later. Go 

to Help > About TradeStation to check your version. 

Earlier versions (9.x, 8.x) are not supported. 
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Part 2: Understanding the Three Indicators 

The AI Channel Trader Pro System Overview 

AI Channel Trader Pro is a three-indicator system. Each indicator has a specific role, and all three are 

designed to work together for a complete trading framework. 

INDICATOR ROLE WHERE IT DISPLAYS 

FA_AIChannelTrader 

(AI Channel Overlay) 

Defines trade zones: 6-band 

adaptive channel, AI trend line, 

session VWAP with deviation 

bands, daily pivot levels, and recent 

high/low reference lines. 

On the price chart (overlay) 

FA_AIChannelPulse 

(Pulse Pro) 

Momentum quality meter: tells you 

whether the current trend is strong 

and expanding or weakening and 

compressing. 

Separate pane below the price 

chart 

FA_AIChannelTrader_PaintBar 

(PaintBar) 

Master directional filter: Cyan bars 

indicate bullish trend direction, Red 

bars indicate bearish trend 

direction. 

Colors the price bars directly 

 

How the Three Indicators Work Together 

Think of the three indicators as answering three essential questions about the market: 

• Direction (PaintBar): The PaintBar tells you the direction. Cyan bars mean long only. Red bars mean 

short only. This is your primary filter and it is non-negotiable. 

• Price Level (Overlay): The Overlay tells you where to trade. The adaptive channel bands define the 

exact price levels for potential entries, exits, and stops. Pivot levels, VWAP, and recent high/low 

provide additional reference zones. 

• Conviction (Pulse Pro): The Pulse Pro tells you the conviction. Bright expanding colors mean the 

momentum supports the trade. Dark compressing colors mean momentum is fading and you should 

be cautious. 

TIP: The highest-quality trade setups occur when all three indicators agree: PaintBar confirms the 

direction, price is at a channel boundary, and Pulse Pro is expanding in the direction of the trade.  
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"The PaintBar tells you the direction. The channel tells you the price. The Pulse tells you the conviction." 
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Part 3: The AI Channel Overlay (TradeStation) 

3.1 The 6-Band Adaptive Channel 

The core of AI Channel Trader Pro is a set of six adaptive bands that act as dynamic support and 

resistance levels. Unlike static support and resistance lines that are drawn manually, these bands 

recalibrate on every bar based on current market conditions. All six bands are displaced one bar 

forward, making them a leading indicator — they project where price is likely to find support or 

resistance before it arrives. 

The channel bands automatically widen during periods of high volatility and narrow during periods of 

compression, adapting to whatever the market is doing. All internal calculations are optimized and 

locked — no user tuning is required or possible. 

BAND COLOR DESCRIPTION 

Outer Resistance Dark Magenta Outermost upper boundary — 

extreme overbought zone 

AI Channel Upper Magenta (thicker line) Core upper channel line — primary 

upper support/resistance 

Inner Resistance Dark Magenta Upper mean-reversion entry zone 

boundary 

Inner Support Dark Cyan Lower mean-reversion entry zone 

boundary 

AI Channel Lower Cyan (thicker line) Core lower channel line — primary 

lower support/resistance 

Outer Support Dark Cyan Outermost lower boundary — 

extreme oversold zone 

 

The two primary channel lines (AI Channel Upper and AI Channel Lower) are drawn with a thicker line 

weight to make them more visually prominent. The inner and outer bands use thinner lines. Together, 

these six bands create zones that define where price is within the channel structure.  

3.2 The AI Trend Line 

The AI Trend Line is a dynamic adaptive line plotted directly on the price chart. It changes color based on 

trend direction: green when the trend is rising (bullish) and red when the trend is falling (bearish). The 

line adapts to market speed — smooth during sustained trends and more responsive at turning points. 
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Use the AI Trend Line as a trend filter. When the line is green, the overall bias is bullish — favor long 

trades. When the line is red, the overall bias is bearish — favor short trades. When the trend line color 

agrees with the PaintBar color, you have strong directional agreement. When they diverge, exercise 

caution. 

3.3 Session VWAP with Deviation Bands 

The AI Channel Overlay includes a Volume Weighted Average Price (VWAP) line with upper and lower 

deviation bands. VWAP represents the average price weighted by volume for the current trading 

session. It is widely used by institutional traders and serves as a key intraday reference level. 

• VWAP Line: VWAP is displayed as a white line on the chart. 

• Deviation Bands: Yellow lines above and below VWAP, controlled by the VW_NumDevsUp and 

VW_NumDevsDn inputs. 

• VWAP Label: A text label showing the current VWAP value appears on the last bar of the chart. 

• Session Reset: VWAP resets at the start of each trading session. 

IMPORTANT: VWAP works best on intraday session-based charts (1-minute through 15-minute). It is 

not meaningful on daily or higher timeframes. On continuous contracts, the session reset may not 

behave as expected — use session-based chart settings for best results. Allow 30 or more minutes 

after the session open for the VWAP bands to develop before relying on them. 

 

3.4 The 7 Daily Pivot Levels 

The overlay includes standard daily pivot levels calculated from the prior day's high, low, and close. 

These provide seven static reference levels that many traders watch: 

LEVEL COLOR DESCRIPTION 

R3 Red Resistance 3 — extreme upper 

level 

R2 Red Resistance 2 — strong resistance 

R1 Red Resistance 1 — first resistance 

above pivot 

PP Yellow Pivot Point — the central reference 

level 

S1 Green Support 1 — first support below 

pivot 
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S2 Green Support 2 — strong support 

S3 Green Support 3 — extreme lower level 

 

Pivot levels act as additional confluence zones. When a channel band aligns with a pivot level, that price 

area carries extra significance. Entries near a pivot level have higher conviction. Pivot display is 

controlled by the ShowPivots input. 

3.5 Recent High/Low 

The overlay can display the highest high and lowest low over a configurable lookback period. These are 

drawn as horizontal reference lines: 

• Recent High: Displayed as a cyan horizontal line. 

• Recent Low: Displayed as a red horizontal line. 

• Configuration: Controlled by the ShowRecentHL input (on/off) and the HL_LookBackPeriod input 

(number of bars to look back). 

Recent High and Low define the current price range. A breakout above the Recent High suggests bullish 

momentum. A breakdown below the Recent Low suggests bearish momentum. These levels are also 

useful for setting maximum stop-loss distances. 

3.6 Input Settings — Complete Reference 

The AI Channel Overlay on TradeStation has exactly 6 user-adjustable inputs. All core adaptive channel 

parameters are internally optimized and locked — no tuning is required. 

INPUT NAME TYPE DEFAULT WHAT IT DOES 

ShowPivots Boolean (True/False) True Show or hide daily pivot 

levels (R3 through S3) on 

the chart. 

ShowRecentHL Boolean (True/False) True Show or hide recent 

high/low horizontal 

reference lines. 

ShowVWAP Boolean (True/False) True Show or hide the session 

VWAP line and deviation 

bands. 

VW_NumDevsUp Float 2.0 Width of the upper VWAP 

deviation band. Higher 

values push the band 
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farther from VWAP. 

VW_NumDevsDn Float -2.0 Width of the lower VWAP 

deviation band. More 

negative values push the 

band farther below 

VWAP. 

HL_LookBackPeriod Integer 10 Number of bars to look 

back for the recent 

high/low calculation. 

 

NOTE: The AI Channel Overlay has 6 user-adjustable inputs. Pulse Pro and PaintBar have zero 

adjustable settings — they work automatically with no configuration needed. 

 

3.7 How to Access Settings 

35. Right-click directly on the AI Channel indicator on the chart. 

36. Select "Format FA_AIChannelTrader..." from the context menu. 

37. The Format dialog opens with Inputs, Style, and Scaling tabs. 

38. Modify input values in the Inputs tab. 

39. Adjust visual properties (colors, line widths, plot visibility) in the Style tab. 

40. Click OK to apply changes. 

41. Save your workspace: File > Save Workspace. 

3.8 What the TradeStation Overlay Does Not Include 

If you have seen screenshots or marketing materials from the TradingView version of AI Channel Trader 

Pro, please be aware of the following differences. The TradeStation version does not include these 

TradingView-exclusive features: 

• No BUY or SHORT signal triangles 

• No Bar Flip diamond markers 

• No Trend Exhaustion X markers 

• No Target or Stop labels (no ShowTargets input) 

• No ChannelWidth input (channel width is internally calculated and locked) 

• No gradient bar coloring (use the PaintBar indicator instead) 

• No channel glow effects (TradeStation uses standard plot lines) 

• No channel midline 

• No pivot zone fills (pivots are displayed as single lines) 
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NOTE: The core trading methodology is the same across both platforms. On TradeStation, trade 

direction is determined by the PaintBar color and trade entries are based on price position relative to 

the channel bands. The PaintBar + Channel + Pulse Pro framework provides a complete trading 

system. 

 

3.9 Understanding Channel Bands as Leading Support and Resistance 

The adaptive channel bands are displaced one bar forward. This means they project where support and 

resistance are likely to be on the next bar, before price gets there. This is fundamentally different from 

lagging indicators that only tell you what already happened. 

Practical applications of the leading bands: 

• Place limit orders at channel band levels in advance of price arriving there. 

• Use Pulse Pro to confirm whether momentum supports a reversal or breakout at the band. 

• Watch for PaintBar color changes at channel bands to confirm trend direction shifts. 
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Part 4: Pulse Pro Oscillator 

4.1 What Pulse Pro Shows 

FA_AIChannelPulse (Pulse Pro) is a momentum and volatility oscillator that displays in its own subgraph 

pane below the price chart. It shows trend strength at a glance through a color-coded momentum 

histogram with directional coloring. 

Pulse Pro measures whether the trend's energy is expanding (getting stronger) or compressing (getting 

weaker). This information is critical for timing entries and managing positions. 

All internal settings are optimized and locked. There are zero user-adjustable inputs — no 

configuration is needed or possible. 

4.2 The Four Momentum States 

The Pulse Pro histogram displays in one of four color states at all times: 

STATE COLOR MEANING WHAT TO DO 

Bullish Expanding Cyan (bright) Momentum is bullish and 

getting stronger 

Stay with long positions. 

Avoid initiating new 

shorts. Best environment 

for long entries. 

Bullish Compressing Dark Cyan Momentum is bullish but 

weakening 

Tighten stops on longs. 

Be cautious with new 

entries. Watch for 

potential reversal. 

Bearish Expanding Red (bright) Momentum is bearish 

and getting stronger 

Stay with short positions. 

Avoid initiating new 

longs. Best environment 

for short entries. 

Bearish Compressing Dark Red Momentum is bearish but 

weakening 

Tighten stops on shorts. 

Be cautious with new 

entries. Watch for 

potential reversal. 

 

The transition between states is particularly informative: 

• Cyan to Dark Cyan: uptrend weakening — prepare to exit longs. 

• Dark Cyan to Cyan: uptrend resuming — look for new long entries. 
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• Red to Dark Red: downtrend weakening — prepare to exit shorts. 

• Dark Red to Red: downtrend resuming — look for new short entries. 

• Dark Cyan to Red: trend reversal — exit longs, prepare for shorts. 

• Dark Red to Cyan: trend reversal — exit shorts, prepare for longs. 

4.3 The Ceiling and Floor Lines 

In addition to the momentum histogram, Pulse Pro displays two gray reference lines: 

• Ceiling (gray line): The upper envelope of the momentum range. Represents the recent expansion 

ceiling. 

• Floor (gray line): The lower envelope of the momentum range. Represents the recent compression 

floor. 

When the Ceiling and Floor lines are far apart, the market is in an active, varied volatility regime. When 

they converge and squeeze close together, the market is in a tight volatility regime — this often 

precedes a significant breakout move. Watch for the histogram to expand beyond the Ceiling after a 

squeeze for a breakout confirmation. 

4.4 Identifying Volatility Expansion Peaks 

Monitor when the histogram bar visually approaches or touches the Ceiling line. This indicates that 

bandwidth expansion is reaching recent peak levels — a sign that the current trend move is at its most 

energetic point. Combined with a PaintBar color confirmation, this can signal a high-conviction entry or 

a warning that the move may be reaching exhaustion. 

4.5 Using Pulse Pro to Confirm Entries 

• Reversal setup: Pulse in a compression (dark) state while price touches a channel band — this is a 

classic mean-reversion setup. Momentum is fading, making a bounce at the band more likely. 

• Breakout setup: Pulse in an expansion (bright) state while price is at a channel band — momentum 

is strong and price may break through rather than reverse. 

• Squeeze breakout: Ceiling/Floor squeeze followed by expansion in one direction — confirms the 

breakout direction. 

4.6 Pulse Pro Alerts 

Pulse Pro includes two built-in alert conditions: 

ALERT TRIGGER 

Volatility Expanding Fires when the Ceiling line makes a new high 
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(expansion envelope is rising). 

Volatility Compressing Fires when the Floor line makes a new low 

(compression envelope is falling). 

 

How to Enable Alerts on TradeStation 

42. Right-click on FA_AIChannelPulse in the subgraph pane. 

43. Select "Format FA_AIChannelPulse..." from the context menu. 

44. Click the "Alerts" tab in the Format dialog. 

45. Check "Enable Alert" for the desired alert type. 

46. Configure your preferred notification method (sound, Alert Log entry, popup window). 

47. Click OK. 

48. To view triggered alerts, go to View > TradeStation Message Center > Alerts tab.  
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Part 5: The PaintBar (TradeStation Exclusive) 

5.1 What the PaintBar Does 

FA_AIChannelTrader_PaintBar is a TradeStation-exclusive component that colors every price bar based 

on the internal trend direction determined by the AI Channel system. This is the master directional filter 

— the most important component for determining trade direction. 

• Cyan bars: Bullish trend regime (uptrend). 

• Red bars: Bearish trend regime (downtrend). 

The PaintBar color flips when the trend direction changes. All internal settings are optimized and locked. 

There are zero user-adjustable inputs — it works automatically with no configuration needed. 

5.2 Why the PaintBar Exists on TradeStation 

On TradingView, bar coloring is built directly into the overlay indicator. TradeStation uses a different 

platform architecture where bar coloring requires a separate PaintBar study. The PaintBar analyzes the 

same internal trend data as the overlay — it is simply delivered through a separate indicator because 

that is how TradeStation handles bar coloring. 

There is no separate PaintBar on TradingView (it is built in). The PaintBar is a TradeStation-only 

component. 

5.3 How to Read the PaintBar 

• Cyan bars: Only look for long trades. Do not initiate shorts. 

• Red bars: Only look for short trades. Do not initiate longs. 

• Color flip: Exit any open trade immediately if the PaintBar flips to the opposite color. This is non-

negotiable. 

• Confirmation wait: After a PaintBar color flip, wait for three or more consecutive bars of the same 

color before entering a new trade. This helps avoid whipsaws. 

IMPORTANT: Never trade against the PaintBar color, even if the channel position looks favorable. The 

directional bias is the primary filter. If PaintBar says cyan, you only go long. If PaintBar says red, you 

only go short. 

 

5.4 How the PaintBar Complements the Overlay and Pulse Pro 

Each indicator answers a different question: 
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• PaintBar: Gives a quick-glance trend reading from the bar colors. Tells you WHICH DIRECTION to 

trade. 

• Overlay: Shows WHERE the support and resistance zones are. Tells you at what PRICE to enter, exit, 

and place stops. 

• Pulse Pro: Shows the momentum STATE. Tells you the CONVICTION behind the current trend. 

Together, the three indicators provide complete market context: colored bars (direction) + channel 

bands (support/resistance zones) + Pulse histogram (momentum quality). The highest-quality setups 

occur when all three agree. 

5.5 Reading Bar Colors for Market Context 

• Consistent cyan bars: Sustained bullish context. The trend is firmly in place. 

• Consistent red bars: Sustained bearish context. The trend is firmly in place. 

• Rapid alternation between cyan and red: Choppy or ranging market. Be cautious with entries and 

consider staying flat. 

• Color change at a channel band: A potential trend reversal confirmation. Watch for follow-through. 

5.6 Practical Notes 

• The PaintBar overrides TradeStation's default bar coloring. 

• If other PaintBar studies are applied, they may conflict. Only one PaintBar should be active at a time 

for clean visuals. 

• To remove the PaintBar: right-click the chart, select Format Analysis Techniques, select 

FA_AIChannelTrader_PaintBar, and click Remove. 

• No alerts are defined in the PaintBar indicator. 
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Part 6: Trading Methodology 

IMPORTANT: This is methodology education, not trade recommendations. Every trader is responsible 

for their own decisions and risk management. AI Channel Trader Pro is an analytical tool, not a signal 

service. 

 

6.1 Core Philosophy 

"The PaintBar tells you the direction. The channel tells you the price. The Pulse tells you the conviction." 

AI Channel Trader Pro supports two core trade types: 

49. Channel Trade (Mean Reversion): Price approaches a channel band and reverses back toward the 

center. You trade the bounce. 

50. Momentum Trade (Breakout): Price breaks through a channel band with strong momentum. You 

trade the continuation after a pullback to the broken band. 

Both trade types are filtered by the PaintBar: cyan bars mean longs only, red bars mean shorts only. 

This is non-negotiable. 

6.2 Understanding Channel Zones 

The six adaptive bands create seven distinct zones on the chart. Each zone has a different trading 

implication: 

ZONE LOCATION TRADING MEANING 

Above Outer Resistance Above the top band Extreme overbought zone. Long 

momentum breakout area or 

exhaustion warning. 

Upper Channel Band Between Outer Resistance and AI 

Channel Upper 

Strong resistance zone. Price here 

is extended. 

Upper Entry Zone Between AI Channel Upper and 

Inner Resistance 

Upper mean-reversion entry zone 

for shorts (when PaintBar is red). 

Neutral Zone Between Inner Resistance and 

Inner Support 

Inside the channel with no clear 

edge. Wait for price to reach a 

boundary. 

Lower Entry Zone Between Inner Support and AI 

Channel Lower 

Lower mean-reversion entry zone 

for longs (when PaintBar is cyan). 
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Lower Channel Band Between AI Channel Lower and 

Outer Support 

Strong support zone. Price here is 

extended. 

Below Outer Support Below the bottom band Extreme oversold zone. Short 

momentum breakout area or 

exhaustion warning. 

 

6.3 Trade Setup Type 1: Channel Trade (Mean Reversion) 

Long Channel Trade 

• PaintBar is cyan (bullish regime). 

• Price is near the bottom of the channel, approaching the Inner Support band. 

• Pulse Pro is in a compression state (dark cyan) — momentum is fading, making a bounce more likely. 

• Entry: Entry: Place a limit buy order at the Inner Support band. 

• Target: Inner Resistance band or AI Channel Upper. 

• Stop: Outer Support band, or exit immediately if PaintBar flips to red. 

Short Channel Trade 

• PaintBar is red (bearish regime). 

• Price is near the top of the channel, approaching the Inner Resistance band. 

• Pulse Pro is in a compression state (dark red) — momentum is fading, making a reversal more likely. 

• Entry: Place a limit sell order at the Inner Resistance band. 

• Target: Inner Support band or AI Channel Lower. 

• Stop: Outer Resistance band, or exit immediately if PaintBar flips to cyan. 

6.4 Trade Setup Type 2: Momentum Trade (Breakout) 

Long Momentum Trade 

• PaintBar is cyan (bullish regime). 

• Price closes above the Outer Resistance band — breakout detected. 

• Pulse Pro is in an expansion state (bright cyan) — strong momentum. 

• Entry: Place a limit buy order at the Outer Resistance band, waiting for the retrace to the broken 

level. Trail the limit order as the channel updates each bar. 

• Target: Recent High level or next pivot resistance (R1, R2, R3). 

• Stop: Inner Resistance band. If price falls back inside the channel, the breakout thesis is invalidated. 

Cancel the setup if PaintBar flips to red. 
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Short Momentum Trade 

• PaintBar is red (bearish regime). 

• Price closes below the Outer Support band — breakdown detected. 

• Pulse Pro is in an expansion state (bright red) — strong momentum. 

• Entry: Place a limit sell order at the Outer Support band, waiting for the retrace. Trail the limit order 

as the channel updates each bar. 

• Target: Recent Low level or next pivot support (S1, S2, S3). 

• Stop: Inner Support band. If price rises back inside the channel, the breakdown thesis is invalidated. 

Cancel the setup if PaintBar flips to cyan. 

6.5 Entry Timing on TradeStation 

TradeStation does not include the BUY/SHORT signal triangles, Bar Flip diamonds, or Trend Exhaustion 

markers that are available on TradingView. On TradeStation, entry timing relies on the combined 

reading of the three indicators: 

• Channel band position: Is price at or near a channel band? This defines potential trade zones. 

• Pulse Pro state: Compression state + band touch is a reversal setup. Expansion state + breakout is a 

continuation setup. 

• PaintBar color: A color change at a channel band confirms a trend shift. Sustained same-color bars 

confirm the current trend. 

• AI Trend Line: Green line supports long bias. Red line supports short bias. Agreement with PaintBar 

strengthens the signal. 

Combine all four elements: Band position + Pulse state + PaintBar color + Trend line direction = your 

complete entry filter on TradeStation. 

6.6 Confluence Hierarchy 

Not all setups are equal. The more confluence factors that align, the higher the probability of a 

successful trade: 

Tier 1 — REQUIRED (the trade does not happen without these): 

51. PaintBar color agrees with trade direction (cyan for longs, red for shorts). 

52. Price is at a channel boundary (not in the middle of the channel). 

Tier 2 — STRONG CONFIRMATION (significantly improves odds): 

53. AI Trend Line color matches PaintBar (green for longs, red for shorts). 

54. Pulse Pro is in the bright expanding state (cyan for longs, red for shorts). 

Tier 3 — CONFLUENCE BONUS (adds additional confidence): 

55. Price is above VWAP for longs or below VWAP for shorts. 

56. Entry is near a pivot support level (for longs) or pivot resistance level (for shorts). 
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57. Trade direction is away from the Recent High/Low boundary, not into it. 

NOTE: On TradeStation, the PaintBar + Channel + Pulse Pro framework is the complete system. There 

are no signal triangles to add as an additional confluence factor. Focus on mastering the three-

indicator approach. 

 

6.7 Trending vs. Ranging Markets 

Trending markets: Trade pullbacks to channel bands in the direction of the trend. PaintBar color is 

consistently cyan or red. Pulse Pro is frequently in the bright expanding state. AI Trend Line maintains a 

steady color. 

Ranging markets: Fade the channel bands — sell at the upper bands, buy at the lower bands. PaintBar 

may alternate more frequently. Pulse Pro often stays in compression states. Be selective and wait for 

clean setups at the band boundaries. 

Use the AI Trend Line color and Pulse Pro states to help determine which regime the market is currently 

in. Consistent trend line color and expanding Pulse suggest trending. Changing trend line color and 

compressing Pulse suggest ranging. 

6.8 When Not to Trade 

58. Pulse Pro is in a dark (compressing) state — momentum is weakening. 

59. PaintBar is rapidly flipping between cyan and red — wait for three or more consecutive same-color 

bars. 

60. Price is stuck in the middle of the channel — no clear edge at any boundary. 

61. AI Trend Line color diverges from PaintBar color — conflicting signals. 

62. VWAP has just reset at session open — wait 30 or more minutes for bands to develop. 

63. Major news events are imminent — volatility may spike unpredictably. 

6.9 Risk Management 

• Position sizing: Risk 1 to 2 percent of account equity per trade. 

• Single exposure: One position at a time per instrument. 

• No averaging down: Never add to a losing position. 

• PaintBar exit rule: If PaintBar flips to the opposite color, exit immediately regardless of profit or 

loss. This is non-negotiable. 

• Dynamic stops: Use channel bands as dynamic stop levels rather than fixed dollar or point amounts. 

• Target levels: Use the opposite channel bands or pivot levels as target references. 
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6.10 Common Mistakes to Avoid 

64. Ignoring Pulse Pro: Always check the momentum state before entering. A channel band touch 

means nothing without momentum context. 

65. Fighting the trend: Do not sell at the upper band during a strong uptrend when PaintBar is cyan and 

Pulse is bright cyan. Respect the direction. 

66. Over-trading: Not every channel band touch is a trade. Wait for confluence from all three indicators. 

67. Using fixed stops: Use the channel bands as dynamic stop levels. Fixed stops ignore the market's 

current structure. 

68. Ignoring the PaintBar: The PaintBar is the master directional filter. Color changes at channel bands 

confirm reversals. Never trade against the PaintBar color. 

6.11 Trade Workflow Summary (TradeStation) 

STEP ACTION WHAT TO CHECK 

1 Check PaintBar color Cyan = long only. Red = short only. 

Non-negotiable. 

2 Check Pulse Pro state Expanding (bright) = active trading 

environment. Compressing (dark) = 

be cautious. 

3 Locate price relative to the channel At a boundary = potential trade 

setup. In the middle = wait. 

4 Check AI Trend Line color Should agree with PaintBar for 

strongest setups. 

5 Place limit order at channel 

boundary 

Channel trade: inner band. 

Momentum trade: outer band. 

6 Manage the trade Monitor PaintBar, Pulse Pro, and AI 

Trend Line as the trade develops. 

7 Exit Hit target (opposite band or pivot 

level), hit stop (outer band), or 

PaintBar flips. 
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Part 7: Frequently Asked Questions 

Q: What version of TradeStation is required? 

A: TradeStation 10 or later is required. Earlier versions including TradeStation 9.5, 9.1, and 8.x are not 

supported. The ELD files are compiled for the TradeStation 10 environment and will not import correctly 

on earlier versions. To verify your version, go to Help > About TradeStation. The version number should 

be 10.0 or higher. 

Q: Do I need a live account or does it work on a demo/simulated account? 

A: AI Channel Trader Pro works on both live and demo/simulated TradeStation accounts. There is no 

difference in functionality between the two. We recommend starting with a simulated account to learn 

the system before trading with real capital. 

Q: What markets and timeframes does it work on? 

A: AI Channel Trader Pro works on any market available in TradeStation, including stocks, futures, and 

forex. It works on any timeframe — minute charts, daily charts, weekly charts, and everything in 

between. The adaptive channel adjusts automatically to whatever market and timeframe you apply it to. 

VWAP is most useful on intraday charts. 

Q: Does it work on range bars and tick charts? 

A: Yes. The adaptive channel works on any bar type supported by TradeStation, including range bars, tick 

charts, and volume-based charts. The channel bands adapt to the bar structure regardless of how the 

bars are constructed. 

Q: Can I use it on multiple charts and workspaces? 

A: Yes. You can add AI Channel Trader Pro to as many charts across as many TradeStation workspaces as 

you need. There is no limit on the number of charts it can be applied to. Each chart operates 

independently with its own adaptive channel calculation. 

Q: How do I receive updates? 

A: Updates are delivered by email. When a new version is available, you will receive a new ELD file with 

instructions. The update process is the same as the initial installation: import the new ELD file using File 

> Import/Export EasyLanguage and click Yes to All when prompted to replace existing files. 

Q: What if I lose my indicator files? 

A: Contact support at frontieralgo.com/support.html and your files will be resent. Please have your 

order confirmation and TradeStation Customer Number available when contacting support for fastest 

resolution. 

Q: Does TradeStation have the signal triangles I see in TradingView screenshots? 
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A: No. Signal triangles (BUY, SHORT), Bar Flip diamond markers, and Trend Exhaustion X markers are 

TradingView-exclusive features and are not available on TradeStation. On TradeStation, trade direction 

is determined by the PaintBar color, and entry timing is based on price position relative to the channel 

bands combined with Pulse Pro momentum state. The core trading methodology is the same — only the 

visual presentation differs. 

Q: Does TradeStation have Target and Stop labels? 

A: No. Target and Stop labels are TradingView-exclusive features. There is no ShowTargets input on 

TradeStation. On TradeStation, use the channel bands themselves as target references (opposite inner 

band for channel trades, next pivot level for momentum trades) and stop references (outer band or 

PaintBar color flip). 

Q: How does the PaintBar relate to bar coloring on TradingView? 

A: On TradingView, gradient bar coloring is built directly into the overlay indicator. On TradeStation, bar 

coloring requires a separate PaintBar indicator due to platform architecture differences. The concept is 

the same — both color the bars by trend direction. The TradeStation PaintBar uses two colors (cyan for 

bullish, red for bearish) rather than a gradient. 

Q: Can I have other PaintBar studies active at the same time? 

A: Only one PaintBar can color bars at a time on TradeStation. If you have another PaintBar study 

applied, it may conflict with the AI Channel PaintBar and one or both may not display correctly. Remove 

other PaintBar studies before adding the AI Channel PaintBar: right-click the chart > Format Analysis 

Techniques > select the conflicting PaintBar > Remove. 

Q: How does VWAP work on continuous contracts? 

A: VWAP works best on session-based intraday charts where it resets at the start of each trading 

session. On continuous contracts, the session reset may not behave as expected during contract 

rollovers. For best results, use session-based chart settings. If VWAP is not relevant to your analysis, set 

ShowVWAP to False to clean up the chart display. 

Q: Do I need to adjust settings for different instruments or timeframes? 

A: No. The default settings work across all instruments and timeframes. The adaptive channel 

recalibrates automatically to the current market conditions. The six user inputs control only display 

preferences (show/hide pivots, VWAP, recent high/low and their parameters). The core channel 

calculations are internally optimized and require no adjustment. 

Q: Can I adjust the channel width on TradeStation? 

A: No. The ChannelWidth input exists only on TradingView. On TradeStation, the channel width is 

calculated internally and locked. All core algorithmic parameters are optimized — no user tuning is 

required or possible. 

Q: What does the "Analysis technique not found" error mean? 
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A: This error means the ELD file was not imported successfully or the import was incomplete. Reinstall 

the ELD file using File > Import/Export EasyLanguage, select the ELD file, and complete the import 

wizard. If the error persists, restart TradeStation completely and try the import again. Verify the 

installation by checking View > EasyLanguage Documents. 

Q: Why is VWAP not showing on my daily chart? 

A: VWAP is a session-based calculation designed for intraday use. It only displays on intraday charts (1-

minute, 5-minute, 15-minute, etc.). On daily or higher timeframes, VWAP is not meaningful and will not 

appear. Set ShowVWAP to False on non-intraday charts to remove the unused element from your 

settings. 

Q: Is there a refund policy? 

A: All sales are final. AI Channel Trader Pro is priced at $247 as a one-time purchase with no subscription 

or recurring fees. There is no refund policy. We recommend reviewing all available information at 

frontieralgo.com before purchasing. 

Q: How do I contact support? 

A: Your first stop for support is the AI chatbot at frontieralgo.com/support.html, available 24/7 with 

instant answers about indicators, settings, installation, and more. For anything the chatbot cannot 

resolve, email contact is available at the bottom of the support page. When contacting support, include 

your TradeStation version, Customer Number, order confirmation, and a description of the issue. 

Q: Does TradeStation Web or Mobile support AI Channel Trader Pro? 

A: No. TradeStation Web and TradeStation Mobile do not support custom EasyLanguage indicators. The 

desktop platform (TradeStation 10) is required. There is currently no web or mobile version of AI 

Channel Trader Pro for TradeStation. 
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Glossary of Terms 

Adaptive Channel: The core set of six bands that dynamically adjust to market conditions on every bar, 

creating zones of probable support and resistance. 

AI Trend Line: An adaptive moving average plotted on the price chart that changes color based on trend 

direction (green for bullish, red for bearish). 

Bandwidth: The width of the adaptive channel. Wider bandwidth indicates higher volatility; narrower 

bandwidth indicates compression. 

Bar: A single unit of price data on a chart, representing a specific time period, tick count, or range.  

Breakout: When price moves beyond an established boundary (such as the Outer Resistance or Outer 

Support band) with momentum. 

Ceiling (Pulse Pro): The upper gray reference line in the Pulse Pro subgraph representing the recent 

expansion envelope. 

Channel Trade: A mean-reversion trade setup where price is expected to bounce off a channel boundary 

and return toward the center. 

Compression: A Pulse Pro state where momentum is weakening. Indicated by dark colors (Dark Cyan or 

Dark Red). 

Confluence: The alignment of multiple independent indicators or levels at the same price point, 

increasing the probability of a trade setup. 

ELD: EasyLanguage Document. TradeStation's native file format for packaging compiled indicator code.  

Expansion: A Pulse Pro state where momentum is strengthening. Indicated by bright colors (Cyan or 

Red). 

Floor (Pulse Pro): The lower gray reference line in the Pulse Pro subgraph representing the recent 

compression envelope. 

Indicator: An analysis technique applied to a chart that processes price data and displays visual output 

(lines, bands, histograms, colors). 

Inner Resistance / Inner Support: The two inner channel bands that define the mean-reversion entry 

zones within the adaptive channel. 

Lookback Period: The number of historical bars used in a calculation. For Recent High/Low, this is 

controlled by the HL_LookBackPeriod input. 

Mean Reversion: A trading concept where price is expected to return to an average or central level after 

deviating from it. 

Momentum: The rate and strength of price movement in a given direction. 

Momentum Trade: A breakout trade setup where price moves beyond a channel boundary with strong 

momentum, and the trader enters on a pullback. 
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Outer Resistance / Outer Support: The outermost channel bands representing extreme overbought and 

oversold zones. 

Overlay: An indicator that displays directly on the price chart, overlaying the price bars. 

PaintBar: A TradeStation-specific indicator type that colors price bars based on a condition. The AI 

Channel PaintBar colors bars cyan (bullish) or red (bearish). 

Pivot Point: A reference level calculated from the prior day's high, low, and close. The central Pivot Point 

(PP) is flanked by support (S1-S3) and resistance (R1-R3) levels. 

Pulse Pro: The momentum oscillator component of AI Channel Trader Pro (FA_AIChannelPulse), 

displayed as a color-coded histogram in a separate pane. 

Recent High / Recent Low: The highest high and lowest low over a configurable lookback period, 

displayed as horizontal reference lines on the chart. 

Session: A defined trading period, typically from market open to market close. VWAP resets at the start 

of each session. 

Subgraph: A separate pane within a TradeStation chart, typically used for oscillators like Pulse Pro that 

need their own vertical scale. 

TSW: TradeStation Workspace. A file that saves an entire chart layout including symbols, timeframes, 

and applied indicators. 

Trend: The general direction of price movement over a period of time. 

Volatility: The degree of price variation over time. Higher volatility means larger price swings. 

VWAP: Volume Weighted Average Price. A session-based calculation showing the average price 

weighted by volume, commonly used as an intraday reference level. 
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Important Risk Disclosures 

Risk Statement 

Trading and investing in financial instruments involves substantial risk of loss and is not suitable for all 

investors. The risk of loss in trading can be substantial. You should therefore carefully consider whether 

such trading is suitable for you in light of your financial condition. The high degree of leverage that is 

often obtainable in trading can work against you as well as for you. The use of leverage can lead to large 

losses as well as gains. 

Key Points to Understand 

AI Channel Trader Pro is a professional analytical tool designed to help identify potential support and 

resistance zones, trend direction, and momentum quality. It is not a trading system that guarantees 

results. No indicator, system, or methodology can guarantee profitable outcomes in financial markets. 

The adaptive channel bands, AI trend line, PaintBar directional filter, and Pulse Pro momentum readings 

represent mathematical analysis of historical and current price data. They reflect current market 

conditions and probabilities — they are not predictions of specific future price movements or outcomes. 

Use AI Channel Trader Pro as part of a complete trading approach that includes your own independent 

analysis, sound risk management practices, and a written trading plan. No single tool should be the sole 

basis for any trading decision. 

All trading decisions are yours alone. FrontierAlgo provides analytical tools only and assumes no liability 

for trading outcomes. AI Channel Trader Pro is not a registered investment advisor, broker-dealer, or 

financial planner. All sales are final. 

Considerations for Getting Started 

69. Use simulation mode first: Paper trade with AI Channel Trader Pro for 2 to 4 weeks before risking 

real capital. This allows you to learn the system without financial risk. 

70. Observe across market conditions: Watch how the indicators behave in trending markets, ranging 

markets, and volatile conditions. Understanding the system across different regimes is essential for 

effective use. 

71. Develop a trading plan: Before committing real capital, write down your entry rules, exit rules, 

position sizing, and risk limits. A trading plan provides discipline and consistency. 

72. Limit risk exposure: Risk no more than 1 to 2 percent of your account equity on any single trade. 

This preserves your capital through inevitable losing trades. 
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Hypothetical Performance Disclaimer 

All examples, illustrations, and trade scenarios presented in this manual are for educational purposes 

only. They do not represent actual trading results and should not be interpreted as indicative of future 

performance. Past performance of any indicator or trading methodology is not indicative of future 

results. 

Complete Legal Disclosures 

For complete legal disclosures, terms of service, and privacy policy, please visit: 

frontieralgo.com/disclaimers.html 

For support and assistance: frontieralgo.com/support.html 

Price: $247 one-time purchase. No subscription. No recurring fees. All sales are final. 
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